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Install and Sign In 
I.		  Install the application

II.		Si  gn in

III.		 Contact Support

IV.		 Customize your profile

I.		  Install the application 

Does my computer meet the requirements for  
Thomson Reuters Eikon?
1.	 Go to https://customers.thomsonreuters.com/Eikon

2.	 Click Check My Computer.

3.	 Follow the on-screen instructions to run System Test.

How do I get my Thomson Reuters Eikon account?
1.	� Your company’s Market Data team or Thomson Reuters Account 

Manager requests a Thomson Reuters Eikon ID on your behalf.

2.	 You receive a Welcome email from Thomson Reuters Eikon.

3.	 Click the link in the Welcome email to activate your account.

How do I install Thomson Reuters Eikon?
After checking that your computer meets the requirements  
and activating your account, you are ready to install  
Thomson Reuters Eikon:

1.	 Go to https://customers.thomsonreuters.com/Eikon/

2.	 Click Sign in  & Download.

3.	� Follow the on-screen instructions to install  
Thomson Reuters Eikon.

II.		Si  gn in

On your desktop
1.	� Point to Start > Programs > Thomson Reuters and choose 

Thomson Reuters Eikon.

2.	 Type your user ID and password.

3. 	� Select Sign me in automatically 
to avoid signing in the next time 
you start the application.

4. 	Click Sign In.

III.		 Contact Support 

If you cannot sign in
Unable to sign in? The most likely cause is an incorrect password or 
no Internet connection. 

Thomson Reuters Eikon online help provides a number of 
troubleshooting solutions: http://bit.ly/14ItX8u (sign-in not required)

After logging in, you can always access help by pressing F1 or using 
the right-click menu.

Should none of these solutions work, contact Thomson Reuters:

1.	 Click the Contact Us link in the Sign In dialog box.

2.	 Fill in the Contact Us page that appears, and click Submit.

On your mobile device 
The single sign-on (SSO) feature with single exchange fees lets  
you access Thomson Reuters Eikon on iOS, Android, and  
BlackBerry devices.

For eLearning, go to  
http://training.thomsonreuters.com/eikon/mobile-solutions

On the web
You can now access key Thomson Reuters Eikon news and data  
on the web, without having to download an application. Just go  
to http://eikon.thomsonreuters.com/login and use your user ID  
and password.

For more information on features: http://tmsnrt.rs/1zfcJCc

For eLearning, go to  
http://training.thomsonreuters.com/video/v.php?v=1378

https://customers.thomsonreuters.com/Eikon/
https://customers.thomsonreuters.com/Eikon/
http://bit.ly/14ItX8u
http://training.thomsonreuters.com/eikon/mobile-solutions
http://eikon.thomsonreuters.com/login
http://tmsnrt.rs/1zfcJCc
http://training.thomsonreuters.com/video/v.php?v=1378
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Get support after signing in
If you encounter problems when working with Thomson Reuters 
Eikon or receive error messages and would like more information, 
you can contact Support.

Go to   > Help > Contact Us. 

Get more help
•	 Click  in the top right of your toolbar to find out what’s new 

in Thomson Reuters Eikon.

•	 Go to  > Help for all help-related options.

•	 For more detailed information on installation, configuration, 
or migration, see online help for Thomson Reuters Eikon 
Installation & Configuration: http://bit.ly/19OvDnz

•	 My Account (http://financial.thomsonreuters.com/myaccount) 
is the single online entry point to Thomson Reuters service and 
support. You can find numerous documents, including the latest 
version of this guide.

Get training
Type TRAINING into the Search box to open the Training App:

•	 View on-demand video tutorials to help you get the most out of 
Thomson Reuters Eikon.

•	 Learn the basics so you can get up and running quickly.

•	 Explore learning by segment to ensure you are making the most 
of the tools available for your market.

•	 Bookmark training so you can complete it at a time convenient 
to you.

IV.		 Customize your profile

Create your profile 
When you sign in for the first time, Thomson Reuters Eikon prompts 
you to customize your profile. Be sure to fill in Job Functions and 
Asset Classes: this information is used to suggest the features and 
apps most appropriate for your role.

You can:

•	 import your LinkedIn™ profile

•	 add a photo

•	 fill in your work history and education

•	 give details about your job role in General Info

•	 enter contact details

This information appears in the Thomson Reuters financial directory 
and improves the results of people-related searches.

Update your profile
You can edit your profile information at any time.

Go to   > Preferences > My Profile to reopen your profile page and 
make your changes.	
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Basic Navigation 
I.		G  et to know the toolbar

II.		Fi  nd apps and define settings 

III.		S earch for content and get Answers

IV.		�B ookmark your favorite content for  
easy access 

I.		G  et to know the toolbar 

Immediately after logging in, the toolbar appears at the top  
of your screen.

Tip: �To move the toolbar, just right-click it and choose Undock,  
then drag it to a new position.

Thomson Reuters Eikon button. 
Click here to access the app menu, 
App Library, saved workspaces, 
settings, and Help.

The Search box is powered by Autosuggest and Answers. 
Use it to find apps, data, or answers to your questions.  
For more information, see page 5.

Open workspaces appear here.  
Workspace 1 is open by default. 

AlertsFavoritesWhat’s New in Eikon

My Briefcase

Messenger

For more help, see Welcome to the Desktop: http://bit.ly/1b1XT7S

For eLearning,  
choose Getting Started with Eikon: New User from the Learn the 
Basics category in the Training App.

You can create, save, close, 
or load workspaces.

http://bit.ly/1b1XT7S
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II. 		Fi nd apps and define settings III.		S earch for content and get Answers

Search box: a starting point for your workflow 
The Search box is your starting point to navigate anywhere.  
Just start typing and Autosuggest will propose results.

Click to open the app menu.

My Apps features apps for 
your specific asset class. 
You can add, remove, or 

rearrange apps in this menu.

Other apps are displayed  
by category.

Click Help to access online help, 
to contact us, to find out what’s 

new, and other support options.

Click Preferences to define 
global options, trading 

settings, and more.

My Workspaces holds all your 
saved workspaces and layouts

The App Library is a searchable 
database of all apps.

Click any app to open it.

4. �If you don’t find what 
you are looking for, press 
Shift+Enter or click here to 
run an advanced search.

3. �Click a result to load 
content. For example, you 
can open the Chart App 
with data for Vodafone 
already loaded.

2. Autosuggest displays results.1. Start typing Vodafone in the Search box.

Sample searches

Company names or common abbreviations Microsoft, Vodafone, ibm

Descriptive terms Comex copper, vodafone common stock

Standard industry codes Ticker, ISIN, Cusip, Sedol, WERT

Specific and partial codes US4592200HJ3, MSFT, USTB

Ticker, coupon, and maturity VOD >7.5%, Vodafone 2015

Country names for country guides France, UK, Japan

News searches on specific instruments or topics IBM news, China news, UST news
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Answers: ask your questions in natural language
Type a query using natural language. Thomson Reuters Eikon Answers will appear at the top  
of the results.

Tip: �You can find answers to frequently-asked questions. 
Start typing How do I... and you will see FAQs in the 
Search results.

1. �For example, you want to compare recent top-line trends for Ford 
and GM. Type Ford vs GM sales.

2. 	�Autosuggest interprets your query. ANS 
prefixes results from Answers. Click the result 
that matches your question to view a detailed 
revenue chart comparing Ford and GM.

Sample Answers queries

Ford vs GM sales

Google EBITDA estimate

French tech companies

IV.		B ookmark your favorite content for easy access

Add apps and other content to your Favorites for easy retrieval later on. Open the Favorites Center  
by clicking  in the top right of any screen.

1.	 Open an app.

2.	 Right-click the app and go to File > Favorites > Add to Favorites.

3. �	� Give your Favorite a name, choose a 
folder to save it in (or create a new one), 
and click Add to save it.

Tip: �Use the Right-Click Favorites folder and 
your Favorites will be available in the 
right-click menu of any app.

For more help, see Working with Favorites: http://bit.ly/1lABHG2 

For more help and to see examples, type ANSWERS 
in the Search box and choose the top result.

http://bit.ly/1lABHG2
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Use your Floating 
Workspace 
I.		E  xplore apps for your asset class

II.		B  rowse the App Library

III.		S et up your workspace

IV.		Li nk apps together

V.		S  ave or share your workspace 

VI.		G et alerts for market-moving events

VII.	�S ync your desktop to your mobile device  
with My Briefcase

Thomson Reuters Eikon – Version 4 features a floating workspace 
that displays multiple apps of your choosing. This flexible format 
means you are not restricted to one size or shape, and can 
customize screen real estate to suit your needs. With just a few 
clicks, you can:

•	 add the apps you want

•	 size them to meet your requirements

•	 “snap” them together so that they move as a single entity

•	 stack them to create tabbed windows so that you can flip back 
and forth

•	 arrange them around other applications such as Microsoft Excel 
or Outlook 

•	 link them together so that they share data

I. 		E  xplore apps for your asset class II.		B  rowse the App Library 

My Apps gives you one-click access to the apps most frequently 
used in your asset class. For example, default apps for an equities 
trader include Quote List, Option Watch, and Time & Sales App.

Begin typing an app 
name in the Search box. 
Results appear below.

Other categories help you find 
the apps suited to your workflow.

Click App Library 
to view the full list 
of available apps.

Click + to add an app to  
My Apps for faster access.

Choose a category or 
asset class to narrow 
down your results.

Tip: �You can rearrange apps in My Apps by 
dragging the icons and dropping them 
to a new location. You can also add or 
remove apps.
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III.		S et up your workspace

Create a new workspace Add apps to your workspace
When you open an app by selecting it in the app menu, the App Library, or through the Search box, it automatically becomes part of your 
active workspace.

Click a workspace name to make it the active workspace. 
You can have up to ten workspaces open at any time.

Right-click a workspace to 
save, close, or rename it.

Click Show Workspace Menu  to:
•	 add a new workspace
•	 access templates for different 

asset classes
•	 share and save workspaces

This example includes a Quote List, 
Option Watch, and News Monitor.

The active symbol (in this case, Renault <RENA.PA>) is the most recent financial instrument you 
have focused on. When you add an app, it automatically displays data for the active symbol.

Click an app title bar to move the 
app. Click and slowly drag an app 
until its frame touches another app: 
the two apps “snap” together, and 
you can move them around as a 
single entity.

Resize an app as you 
would any other window: 
just click the frame and 
drag to the new size.

Use auto-stacking so that new 
apps open automatically as 
tabs in the same window.  
This saves screen real estate.

Go to  > View > Auto Stack 
Window to turn auto-stacking on. 

Add News Monitor to your workspace 
to get:
•	 the latest market-moving news 
•	 historical news archives 
•	 feature-rich, intuitive user interface

For more help, see About News Monitor: http://bit.ly/1zdAtXg For eLearning, go to choose The News Monitor App from the 
Price & News Discovery category in the Training App.

http://bit.ly/1zdAtXg
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IV.		Li nk apps together

You can link apps together so that they share the content of your chosen instruments. Color-coded apps 
“tune in” to the same data stream.

V.		S  ave or share your workspace

After creating your workspace, you can save it for later use or share it with colleagues. Just right-click 
the workspace tab in the application toolbar, and choose Save. You will also be prompted to save any 
unsaved workspace changes when you close Thomson Reuters Eikon.

1. �This example includes Index 
Movers App, Quote Line App, 
and a company overview page.

2. �In the top left of each app, click Link Channel  
to choose a color.  
Choose whichever color you prefer.

3. �Now that the apps are linked, type a new instrument code into any app. 
All other apps will automatically display content for the new instrument.

1. �Right-click the workspace tab and choose Save.

3. �View your saved workspaces and layouts. You can share content 
with your colleagues or other Messenger contacts – just click Share.

For more help, see Linking Apps: http://bit.ly/1nTLlm1

For eLearning, choose Managing the Eikon Workspace from the Learn 
the Basics category in the Training App. 

2. �To see your saved workspaces, click View Workspace Menu  
and choose My Workspaces.

http://bit.ly/1nTLlm1
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3. �Choose the type 
of data or event to 
trigger the alert.

4. �Fill in the alert criteria. For example, you can receive an alert when the 
instrument price hits a certain threshold. You can easily combine criteria,  
and Autosuggest helps you find the right instrument quickly.

5. Choose how you want 
to receive alerts.

6. Click Set to activate 
your alerts.

Tip: �You can set alerts directly from other apps. Just right-click 
the instrument you are interested in and choose Set Alert.

VI.	G et alerts for market-moving events

Get informed immediately of market-moving information with Alerts. 

1. �Click  in the top right of the toolbar to open Alerts.

2. Click Create New Alert.

For more help, see Creating and Managing Alerts:  
http://bit.ly/1nTsvex

For eLearning, choose Creating and Managing Alerts from the 
Price & News Discovery category in the Training App.

http://bit.ly/1nTsvex
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VII.	S ync your desktop to your mobile device with My Briefcase

With My Briefcase, you can collect news and documents and read them later, either on your desktop 
application or from your mobile device, even when you are offline. You can open My Briefcase by clicking   

 in the top right of your toolbar.

1. �Open an app and display filings, research, events, or news.  
For example, country news is available in  > Markets > Countries & Regions.

2. Click Add to Briefcase.

4. �Go to Briefcase in the Applications 
menu to find the article you saved.

3. �Sign into your  
mobile device. 

For more help, see Using My Briefcase: http://bit.ly/LPUa1s

For eLearning, choose Using the Briefcase from the Price & 
News Discovery category in the Training App.

http://bit.ly/LPUa1s
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Monitor your Portfolios 
I.		M  ake a portfolio or list

II.		�FOLLOW   news that affects your portfolio 

III.		W atch the markets with Monitor

I.		M  ake a portfolio or list 

Lists are sets of financial instruments that you define. Portfolios are 
predefined or custom lists that include the quantity of each financial 
instrument, as well as historical purchase prices. You can:

•	 create lists and portfolios 

•	 use predefined portfolios, for example, based on major  
stock indices

•	 share them with other colleagues

•	 reuse them in other apps, or on your mobile device

•	 export them to Microsoft Excel

1. 	 Open Portfolios and Lists.

	� Remember, you can open an app from the app menu, or find it 
using the Search box.

2. In this example, let’s make a 
portfolio. On the Portfolios And 

Lists tab, click Create New. 

5. Use the tabs at the top 
of the app to run analytics, 

create reports, search for 
news about the instruments 
in your portfolio, and more.

6. Add holdings to your 
portfolio here. You can 

then indicate transaction 
dates and values on the 

Transactions tab.

3. �Enter details for your new 
portfolio, including a name, 
benchmark index, primary 
asset class, and currency.

4.	� Click Create to make your new empty portfolio.

	� On the next screen, you will add instruments 
and other details.

For more help, see Portfolios and Lists: http://bit.ly/1jfBlmq

Tip: �Thomson Reuters Integration Services can help upload your 
portfolios easily. Contact your Thomson Reuters representative.

http://bit.ly/1jfBlmq
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II.		FOLLOW   news that affects your portfolio 

News Discovery offers different insight into NewsWires, Global Press, and Reuters Top News through 
data visualization.

•	 Get streaming and historical news enhanced by charts, videos, tweets, and more.

•	 Charts and story snippets in the headline dashboard tell you the crux of the story at a glance.

•	 View news on the companies in your portfolios.

•	 Filter by story sentiment (NewsWires only), or by date and time.

•	 Add advanced filters and save them just as you do in News Monitor.

•	 Create filters, order by date/time or sentiment, or simply view news for the current day.

News Discovery is available in the News & Research app menu, or by typing NEWSD in the Search box.

III. 	W atch the markets with Monitor 

Monitor lets you watch instruments and multiple portfolios. You can create and modify your Monitor 
quickly and easily, choosing data fields from the Thomson Reuters Eikon database and sharing your list 
with colleagues.

You will find Monitor in the Monitoring app menu. 

Remember, you can open an app from the app menu, or find it using the Search box.

To create your instruments, 
launch Monitor and just start 
typing. Enter ticker symbols, 
or type a company name and 
choose from Autosuggest.

Press Enter to go to the next 
line, Delete to delete a row, 
Insert to add one, Ctrl-z to undo 
an action, or Ctrl-y to redo one.

Right-click a header to 
sort data or add columns.

Also use the right-click 
menu to access  
display preferences.

You can create multiple Monitor lists. 
The app saves your changes 
automatically. To access saved lists or 
to rename lists, click the app menu 

 and choose File > Open or Rename.

For indices, you can expand or contract the 
list of constituents by clicking the gray arrow.

Double-click a header name to change the 
data field. Autosuggest helps you find the 
Thomson Reuters data you are looking for.

For more help, see Monitor:  
http://bit.ly/1lAH7kn

For eLearning,  
choose Monitor your Portfolios and Lists from the 
Price & News Discovery category in the Training App.

Choose how you want to 
filter news. In this example, 
let’s filter by portfolio.

Select the portfolio you want.  
All news articles related to 
instruments in your portfolio  
are displayed.

Hover over the top right of an article to 
display the Briefcase icon. Click Add to 
Briefcase to save your article so that you 
can read it on the go from your mobile 
device or web browser.

Select the news sources you require, 
and add advanced filters in this area.

Use the Timeline toggle button to display news 
in reverse chronological order or based on the 
date and time criteria you have chosen.

http://bit.ly/1lAH7kn
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Charting and Technical Analysis 
I.		U  se a workflow chart

II.		  Create a custom chart in Chart App

I.		U  se a workflow chart

Workflow charts are predefined charts for various asset classes. You can find them under Charting.

1. Click to open the app menu.

2. Click Charting. Workflow 
charts for your asset  
class appear, along  

with Chart App. 

3. Select a chart, for example,  
select Volatility Chart. 

4. �Fill in the instrument, analysis parameters, and other settings.
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II. 		 Create a custom chart in Chart App

Chart App is a powerful, flexible tool for technical analysis. Build your analysis from scratch and 
configure it to fit your needs.

1. Click to open the app menu.

2. Click Charting. Workflow 
charts for your asset class 

appear, along with  
Chart App. 

3. Select Chart. 

4. Type an instrument code and press Enter.

5. �Use toolbar buttons to adjust your chart range, 
interval, and line types. Click  to add  
a new analysis.

Tip: �To edit your chart, just click any label and choose a new setting from the drop-down box that appears. 

6. In the Insert Analysis dialog 
box, select an analysis and 

click Add to insert it. To find 
out more about an analysis, 

select it and press F1 to  
open online help.

For more help, see Charting & Technical Analysis: 
http://bit.ly/14cMiKM

For eLearning, choose Getting Started with the Chart App from 
the Charting category in the Training App.

http://bit.ly/14cMiKM
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Financial Communities 
I.		U  se Thomson Reuters Messenger

II.		  Contact Customer Support for help

III.		�S end messages directly from the Search box

IV.		�S earch the Directory, view profiles,  
and build your network

Begin typing here to 
search the directory 

or your contacts.

Right-click a contact 
name to view their 
profile, or double-

click to start a 
conversation.

View active 
conversations  

in this area.

Use these buttons 
to add a contact, 

create a group, or 
send a blast.

Click  on the toolbar to open Messenger.

For more help, see Overview of  
Thomson Reuters Messenger: 
http://bit.ly/1plFAS8

Tip: Messenger is enhanced every month with new features. 

To find out about new enhancements, don’t forget to check the What’s New page frequently. 
Just click  in the top right of your toolbar.

I.		U  se Thomson Reuters Messenger

For eLearning, 
choose Getting Started with Eikon Messenger from 
the Collaborating category in the Training App.

Messenger is also a venue for chats and forums. Check 
out the weekly Global Markets Forum, where you can get 
commentary from leading Reuters journalists.  
Visit http://online.thomsonreuters.com/trading/gmf/

http://bit.ly/1plFAS8
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II.		  Contact Customer Support for help

If you need help, you can contact Thomson Reuters Customer Support 
anytime from Messenger. Just click Customer Support in the Ungrouped 
category of contacts.

III.		S end messages directly from the Search box

You can send a quick message to any of your contacts (including Customer 
Support) without opening Messenger.

1. Just type @ and your contact’s name in the Search box…

2. …then type your message and press Enter. 

Tip: �You can also write to chat rooms and groups 
you create in your list of contacts.

IV. 	S earch the Directory, view profiles, and build your network 

Messenger gives access to a global financial services directory for the combined Thomson Reuters Eikon and Markit Collaboration 
Services networks. This is the financial services industry’s first open, cross-network directory. It enables users across the industry – 
including those on internal networks – to find and communicate with each other safely and compliantly. 

Over 250,000 users are now accessible across the combined Eikon and Markit networks.

1. In Messenger, 
begin typing to 

search for a person 
or company.

2. Right-click a 
name to view  
more details.

3. Click Add to  
My Contacts or  

View Profile.

4. On the profile page:

•  See the person’s 
profile and  

contact details

•  Send a message via 
Messenger or email

•  Add your own 
personal notes  

(not visible to  
other users)

•  View related contacts
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Thomson Reuters Eikon – 
Microsoft Office 
I.	�	�Di  scover Thomson Reuters Eikon –  

Microsoft Office

II.		�L  og into Thomson Reuters Eikon –  
Microsoft Office

III.		�U se the Formula Builder to retrieve  
Thomson Reuters data

IV. 	�ENABLE  DATASTREAM, DEAL ANALYTICS,  
LINKING, AND PRESENTATION TOOLS 

V.		�U  se Adfin Analytics and other  
advanced features 

I. 		�Di  scover Thomson Reuters Eikon – 
Microsoft Office

Thomson Reuters Eikon – Microsoft Office, an integral part of 
Thomson Reuters Eikon, is a self-installing Microsoft Excel add-in. 
With it, you can: 

•	 retrieve real-time, historical, and fundamental data by using the 
Formula Builder or the In-Cell Builder

•	 analyze equities using the integrated Screener

•	 build charts with your financial data in your worksheets for 
market analyses

•	 access and customize advanced templates provided by  
Thomson Reuters 

•	 build lists and portfolios, and access those created in  
Thomson Reuters Eikon Desktop

•	 export and link Excel data and charts to documents or 
presentations in Word or PowerPoint

•	 create presentations and documents customized to your 
company’s own visual identity

II.		�L  og into Thomson Reuters Eikon – 
Microsoft Office

1. Start Microsoft Excel.

2. �Click the Thomson Reuters tab to open 
the Thomson Reuters Eikon menu.

3. �Click Log in and type your Thomson Reuters 
Eikon credentials if prompted.

III. 	�U se the Formula Builder to retrieve 
Thomson Reuters data

1. �Select a blank cell on your worksheet, then click 
Build Formula on the Thomson Reuters tab.

2. �In the Formula Builder, 
enter (or search for) 
the instruments you 
want data for.

3. �Select the data source you require 
(real-time & fundamental or time 
series), then enter the data item(s) 
you want to include. For each data 
item, you can define settings in the 
Parameters area.

4. �Select other settings, 
if required.

5. �Select a destination 
cell for the data.

6. Click Insert.

Open the Training App and choose the Excel & Analytics 
category to see the full range of training materials for Thomson 
Reuters Eikon – Microsoft Office, from basic features to 
advanced data retrieval and automation.
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IV. 	�ENABLE  DATASTREAM, DEAL ANALYTICS, LINKING, 
AND PRESENTATION TOOLS 

Thomson Reuters Eikon – Microsoft Office includes additional apps 
to enhance your productivity.

Note: You must be permissioned to enable these apps.

V.		�U  se Adfin Analytics and other  
advanced features

Adfin Analytics is a set of powerful cross-market financial 
calculation libraries. The libraries are targeted for financial 
spreadsheet users and developers of financial applications.  
The libraries can be used in different environments, for example  
in Thomson Reuters Eikon – Microsoft Office. 

Tip: �In Microsoft Excel, go to Formulas > Insert Function to access 
the Adfin Analytics functions.

1. �Click Options on the Thomson Reuters tab.

The worksheet embeds the new formula in the cell you selected, and 
retrieves the related data.

In this example, the TR function is used. To find out more about this 
powerful and versatile function, see http://bit.ly/1ijec1W 

2. Open Apps.

3.	 Click to read about and enable the app(s) you require:

•	 Datastream

•	 Datastream Charting

•	 Deal Analytics

•	 Linking

For more help, see Thomson Reuters Eikon Adfin Workbook: 
http://bit.ly/15g0IMo

For more help, see Thomson Reuters Eikon –  
Microsoft Office Help: http://bit.ly/1hIJixa

For eLearning, 
choose Getting Started with Eikon – Microsoft Office from the 
Excel & Analytics category in the Training App.

http://bit.ly/1ijec1W
http://bit.ly/15g0IMo
http://bit.ly/1hIJixa


20

CONTACT INFORMATION
For online help: http://bit.ly/1n8tB37

For more information on training: http://training.thomsonreuters.com/eikon4/

Or contact your Thomson Reuters representative.
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